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FX Tools Software Package - FX 
CommPro BACnet® User Guide 

Introduction 
The FX CommPro BACnet® software is part of the FX Tools Pro and 
FX Tools Express software suite. Use FX CommPro BACnet software 
to download application software to Facility Explorer field controllers 
fitted with BACnet communication cards and to perform online 
commissioning activities. 

Commissioning refers to a set of processes that ensures the control 
application operates according to the intended specification. 
FX CommPro BACnet tool allows you to test the control application 
with connected Facility Explorer controllers. 

FX CommPro BACnet tool allows you to: 

• read the device status 

• download new control applications 

• upload control applications (FX16 BACnet Rev. B only) 

• read and write properties of the BACnet objects in the network 
profile 

• modify parameters 

• read device-specific data 

To communicate with FX CommPro BACnet tool, the field controllers 
must have a BACnet communication card installed. Refer to the 
Facility Explorer documentation for the appropriate controller ordering 
information. 

This document assumes that users are familiar with the 
BACnet protocol and Microsoft® Windows® Operating System (OS). 
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Installation and Startup 

Installing FX CommPro BACnet Tool 
Windows Operating System Upgrade 

FX CommPro BACnet tool uses the Microsoft .NET Framework; 
therefore, you need to install Microsoft .NET Framework Version 2.0 
to run FX CommPro BACnet tool. 

Upgrade the Windows OS on your computer before you proceed with 
the tool installation. 

The .NET Framework Version 2.0 
The .NET Framework is a component of the Microsoft Windows OS 
used to build and run Windows OS based applications. 

Checking the .NET Framework Installation 
To check the .NET Framework installation: 

1. From the Start menu, go to the Control Panel. 

2. Double-click Add or Remove Programs. The Add or Remove 
Programs window appears. 

3. Scroll down the list of applications. If Microsoft .NET Framework 
Version 2.0 appears, then the Windows OS upgrade is not 
necessary. 

Getting Microsoft .NET Framework Version 2.0 
To get Microsoft .NET Framework Version 2.0, go to the FX Tools 
Pro CD. 
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Installing FX CommPro BACnet Tool 
To install FX CommPro BACnet tool: 

1. Close all open programs. 

2. Insert the FX Tools CD-ROM into the CD-ROM drive. The 
FX Tools starts automatically. The CD-ROM Navigator appears 
(Figure 1). 

Note: If FX Tools does not start, select Autorun.exe to start it 
manually. 

 

Figure 1: FX Tools Pro Software Menu 
3. From the Software menu, click FX CommPro BACnet. The FX 

CommPro BACnet Open Setup Wizard appears (Figure 2). 
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Figure 2: FX CommPro Installation Wizard 
4. Click Next. The Select Destination Folder window appears  

(Figure 3). 

 

Figure 3: Destination Folder Window 
5. To install FX CommPro BACnet tool in a directory other than the 

default directory shown in the Destination Folder box, click 
Browse and select a different directory. 

6. Select Everyone to install FX CommPro BACnet tool for anyone 
who uses the computer. Select Just me to install FX CommPro 
BACnet tool for yourself. 

7. Click Next. The Confirm Installation window appears (Figure 4). 
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Figure 4: Confirm Installation Window 
8. Click Next. The Installing FX CommPro BACnet window displays 

the progress of the installation (Figure 5). The FX CommPro 
BACnet Information window appears (Figure 6). 

 

Figure 5: Installing FX CommPro BACnet Window 
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Figure 6: FX CommPro BACnet Information Window 
9. Click Next. The Installation Complete window appears (Figure 7). 

 

Figure 7: Installation Complete Window 
10. Click Close. 

Note: Do not rename the program directory after the program has 
been installed. 
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FX CommPro BACnet Tool 
Navigation 

Starting FX CommPro BACnet Tool 
To start FX CommPro BACnet tool, select Programs > FX Tools > 
FX CommPro > FX CommPro BACnet from the Windows Start menu. 

Main Window 

 

Double-click on window 
headers to make the 
window full size.  

Double-click again to 
return the window to its 
original size. 

Figure 8: FX CommPro BACnet Tool Main Window 
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The FX CommPro BACnet tool main window contains the following 
areas: 

• Menu Bar and Toolbar - provides an interface to the available 
actions allowed for the menu item or button you select. 

• Network View - displays the identified BACnet devices, which 
includes their type and address. 

• Details View - provides details about the selected BACnet device. 

• Profile View - lists the BACnet points available to monitor, adjust, 
or command. 

• Watch View - displays information of multiple points 
simultaneously. 

• Status Bar - displays general information about the operation of 
the tool Network View area to show connected devices and their 
network variables. 

Note: To view a window as a full size window, double-click on the 
window header. To return the window to its original size, double-click 
the window header again. 

Menu Bar 
In the Menu Bar (Figure 9), you can click on a menu item for a list of 
corresponding options. Available options appear in black. Unavailable 
Options appear in gray. 

 

Figure 9: Menu Bar 
File Menu 
The File menu includes the following options: 

• Load Session – opens and automatically reestablishes the session 
exactly as it was previously saved. 

• Save Session - saves the session. This includes the connection 
settings, the devices that were scanned, and the watch view. 

• Load watchtemplate – opens a Watch Template. The Watch 
Template provides a way for you to customize Watch Views. 

• Save watchtemplate – saves a customized Watch View to a 
Watch Template. 
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Connection Menu 
Use the Connection menu to open or close the network interface 
between FX CommPro BACnet tool and the field controllers. 

• Open - provides a link to the Open Connection window. 

In the Open Connection window, you can define and establish the 
network interface between FX CommPro BACnet tool and a 
BACnet network. Once the connection is established, the Scan 
BACnet window appears, allowing you to discover the devices on 
the BACnet network. 

• Close - closes the network interface between FX CommPro 
BACnet tool and the BACnet network. 

Network Menu 
Use the Network menu to scan for devices on the BACnet network or 
to remove all devices from the Network View. 

The Network Menu includes the following options: 

• Scan - discovers all devices on the BACnet network within a 
user-identified range of MAC addresses. 

• Remove All - removes devices from the BACnet network. 

Tools Menu 
The Tools Menu provides the following options: 

• Settings - allows you to change the network connection 
parameters, device and object polling rates, Application Layer 
Protocol Data Unit (APDU) timeout, and write priority level. 

View Menu 
The View Menu allows you to show or hide the Network View, 
Details View, Profile View, and Watch View. 
About Menu 
Use the About Menu to view information about FX CommPro BACnet 
tool, including the revision. 
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Toolbar 
The buttons in the toolbar (Figure 10) provide a shortcut to specific 
functions in FX CommPro BACnet tool. Table 1 shows the toolbar 
icons and describes their functions. 

 

Figure 10: Toolbar 

Table 1: Toolbar Icons 

Icon Description 

 Opens a connection. 

 
Closes a connection. 

 Scans the network for all devices 
within a specified Media Access 
Control (MAC) address range. 

 
Not used 

 
Allows you to change the network 
connection parameters, device, and 
object polling rates; APDU timeout; 
and write priority level. 

 
Provides information about FX 
CommPro BACnet tool. 
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Network View 
The Network View shows all the devices currently connected to 
FX CommPro BACnet tool (Figure 11). 

 

Figure 11: Network View 

Network View Right-Click Options 
You can add devices to the Network View or show/hide the network 
number when you right-click on an empty area in the Network View 
(Figure 12). 

 

Figure 12: Network View Right-Click Menu Items 
The right-click options include the following: 

• View - allows you to show or hide the BACnet network number. 

• Add Devices - opens the Scan window. Use the Scan window to 
discover BACnet devices within a specified range of MAC 
addresses. 

Once devices appear in the Network View, you can perform several 
actions when you right-click on the selected device (Figure 13). 
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Figure 13: Network View Right-Click Menu Items 
The right-click options include the following: 

• Explore Profile - populates the Profile View with a tree showing 
all the objects in the BACnet device. 

• Rename - allows you to change the name of the device. 

• Remove Controller - removes the selected device from the 
Network View. 

• Time and Date - updates the time and date of the selected devices 
to the time and date of the computer. 

• Reinitialize Device>Cold Start - initiates a cold start of the 
selected devices. 

• Reinitialize Device>Warm Start - initiates a warm start of the 
selected devices. 

• Application > Download - downloads the desired application 
software file to the selected devices. 

• Firmware > Download - downloads the desired firmware file 
(*.a37) to the selected devices. 

• Open Peer-to-Peer Plug-in - opens the Peer-to-Peer plug-in, 
allowing you to define peer-to-peer data transfer bindings between 
client and server devices. 
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Profile View 
The Profile View contains a tree that shows the application’s BACnet 
profile points inside the selected device (Figure 14). 

 

Figure 14: Profile View 

Profile View Right-Click Options 
When you right-click on the device name, or in an empty area of the 
Profile View (Figure 15), you can do the following: 

• change the view mode between Group and Hierarchy 

• sort objects by their Name or Instance Number 

• add all objects to the Watch View 

• remove all objects from the Watch View 

 

Figure 15: Profile View Right-Click Options 
By right-clicking on the object, you can add or remove it from the 
Watch View. 
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Details View 
The Details View contains detailed information about the device you 
select in the Network View or the object you select in the Controller 
Profile View (Figure 16). 

 

 

Figure 16: Details View 
Information contained in the white fields is writable, whereas 
information contained in gray fields is read-only. 
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Watch View 
The Watch View displays detailed information about objects from one 
or more devices (Figure 17). The detailed object information includes 
the following: 

• Object Type 

• Object Name 

• Device Address 

• Status 

• Present Value 

• Unit of Measure 

• Polling Rate 

 

Figure 17: Watch View 
You add objects to the Watch View from the Profile View. Objects in 
the Watch View appear in rows. Click on the column header to sort the 
objects (click once for ascending and click again for descending). 

To remove an object from the Watch View, right-click on it and select 
Remove Watch. 

To perform actions on one or more points, right-click on the points and 
select the desired action from the list (Figure 18). These actions 
include the following: 

• Write to or override the point. 

• Remove from Watch View. 

• Change the poll rate. 

 

Figure 18: Watch View Right-Click Options 
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Connecting to Devices 
FX CommPro BACnet tool (Figure 19) communicates via Internet 
Protocol (IP) over Ethernet. To connect FX CommPro BACnet tool to 
a Master-Slave/Token-Passing (MS/TP) field controller, you must 
install and configure a BACnet IP to MS/TP router or other adapter. 
We recommend you use the LP-KIT204-000C BACnet IP to MS/TP 
adapter. 

 

Figure 19: FX CommPro BACnet Tool Connection 

Configuring the Network Settings of the Computer 
You need to configure your computer’s network settings so that the 
computer can communicate with the BACnet Ethernet / MS/TP router.  

To configure the network settings of the computer: 

1. From the Start menu, select Network Places. The Network Places 
window appears. 

 

Figure 20: View Network Connections 
2. From the Network Tasks section, select View network connection. 

The Network Connection window appears. 
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3. Right-click Local Area Connection and select Properties. The 
Local Area Connection Properties dialog box appears. 

 

Figure 21: Local Area Connection Properties 
4. In the list of connections, select Internet Protocol (TCP/IP) and 

click Properties. The Internet Protocol (TCP/IP) Properties window 
appears. 

 

Figure 22: Internet Protocol (TCP/IP) Properties 
5. Click Use the Following IP Address and enter a unique IP address. 

The first three quads of the IP address must match those of the 
Ethernet / MS/TP router. The final quad can be any value from 
3 to 254 (the value is not used by router or any other device on the 
Ethernet network). 

Connecting FX CommPro to BACnet Devices 
To connect to a device: 

1. Connect the router to the computer running FX CommPro BACnet 
tool with a straight-through Ethernet cable. 

2. Connect the BACnet devices to the MS/TP end of the router. 

3. Start FX CommPro BACnet tool. 

4. Click the Open Connection. The Connection window appears 
(Figure 23). 
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Figure 23: Connection Window 

5. Select the computer’s network interface. 

6. Click Configure. The Router Settings window appears (Figure 24). 

 

Figure 24: Configure Router Settings 
7. Enter the IP address, UPD port, and network number for the router. 

Note: The Router Network Number setting needs to match the 
network number setting in the BACnet router. The BACnet IP to 
MS/TP router (LP-KIT204-000C) ships with a default network 
number of 2001. For other BACnet IP to MS/TP Routers, refer to 
the manufacturer’s documentation. 

8. Click OK. The Connection window reappears. 

9. Click Connect. The Scan BACnet Network window appears 
(Figure 25). 
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Figure 25: Scan BACnet Network Window 
10. Enter a range of MAC addresses and click Scan. 

Enter the range in the Discovery Master on the Network section to 
discover only master devices (1-127). 
Enter the range in the Discovery Master and Slave on the Network 
section to discover both master and slave devices (1-255). 
FX CommPro BACnet tool scans for all devices within the 
specified address range. A status bar shows the progress. Once the 
scan finishes, the main window appears. The Network View 
displays all the found devices. 

11. To add more devices, select Scan from the Network menu. 

Note: You can also right-click in the Network View and select 
Add Devices. 
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Downloading Files 
You use FX CommPro BACnet tool to download the application 
software file (*.apd) into the FX field controllers. In addition, you can 
use FX CommPro BACnet tool to download firmware to the FX field 
controllers. 

Downloading Application File to FX Controllers 
Before you download an application to a controller, you must first 
connect the FX CommPro BACnet tool to the device. For more 
information, see Connecting to Devices. 

In the FX CommPro BACnet tool, you can download a single 
application file to a device. You can also select multiple different 
devices and then download multiple applications at the same time. 

To download an application file to the FX controllers: 

1. In the Network View, select the target device. 

Note: If necessary, you can select more than one device. 

2. Right-click the selected device (Figure 26) and select Download 
from the Application menu. The Select File to Download window 
appears. 

 

Figure 26: Selecting Application Download 
3. Select the desired application file (.apd) and click Open. The 

Download Operation Status window appears (Figure 27). 
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Click to sort 
on the 
device 
address. 

Select the 
application 
(.apd) file for 
each controller. 

Figure 27: Download Operation Status Window 

4. Click the browse button in the Application File column for the 
desired controller and select the application (.apd) file. 

Note: 

Note: 

You can use Ctrl or Shift to select two of the same 
controllers and then select an application file for both controllers. 
The same application then appears for both devices. 

If you select an application that is not compatible to the device you 
selected, a message appears in the Notes column saying Device 
not Compatible. If necessary, right-click on the device with the 
incompatible application and select Clear File or Remove Device. 

If you remove a device, then you need to go back to the 
main screen to add it again. 

5. Click Start. The download process starts. 

The Download Operation Status window (Figure 28) displays the 
progress of the application download operation. When the 
download operation finishes, the Progress cell displays a 
Download Completed message. 

 
Figure 28: Download Operation Progress 

6. Click OK to exit the Download Operation Status window. 
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Downloading Firmware to FX Controllers 
Before you download firmware to a controller, you must first connect 
FX CommPro BACnet tool to the device. For more information, see 
Connecting to Devices. 

To download firmware to the FX controllers: 

1. In the Network View, select the target device. 

Note: If necessary, you can select more than one target device. 

2. Right-click the selected device (Figure 29) and select Download 
from the Firmware menu. The Select File to Download window 
appears. 

 

Figure 29: Selecting Application Download 
3. Select the desired firmware file (.a37) and click Open. The 

Download Operation Status window appears (Figure 30). 

 

Figure 30: Download Operation Status Window 
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4. Click Start. The download process starts. 

The Download Operation Status window (Figure 31) displays the 
progress of the firmware download operation. When the download 
operation finishes, the Progress cell displays a Download 
Completed message. 

 

Figure 31: Download Operation Progress 
5. Click OK to exit the Download Operation Status window. 
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Setting the Time and Date 
Use FX CommPro BACnet tool to set the controller’s time and date. 
Before you set the controller’s time and date, you must first connect 
FX CommPro BACnet tool to the device. For more information, see 
Connecting to Devices. 

To set the controller’s time and date: 

1. In the Network View, select the target device. 

Note: If necessary, you can select more than one target device. 

2. Right-click the selected device (Figure 32) and select Time and 
Date. Two options appear:  

• Time Synchronization 

Select Time Synchronization to set the controller’s time and 
date to that of the computer’s time and date. 

• UTC Time Synchronization 

Select UTC Time Synchronization to synchronize the 
controller’s Universal Time Coordinated (UTC). The local time 
is calculated by subtracting the UTC Offset in the 
FX controller from the UTC time received in the UTC Time 
Synchronization. 

 

Figure 32: Setting the Controller’s Time and Date 
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Defining a Watch Template 
You can define a Watch Template to customize the Watch View with 
specific point information. Once you create a Watch Template, you 
can assign it to one or more devices. This allows you to easily compare 
similar points sourced from different devices. 

To define a Watch Template: 

1. In the Network View, right-click the device and select Define 
Template from the Watch Template menu (Figure 33). 

 

Figure 33: Define Watch Template 
2. From the Profile View, right-click the points you want and select 

Add Objects to Watch Template (Figure 34). The point 
information appears on the Standard Objects tab. 
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Figure 34: Add Objects to Watch Template 
3. On the File menu, click Save Watch Template. 

4. Enter the name of the template and click Save. The name you 
entered now appears on the Customer Template tab. 
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Applying a Watch Template to a Device 
Once you customize the Watch View, you can assign the defined 
template to another device. Defining Watch templates and then 
assigning the template to other devices allow you to easily compare 
different points to each other. 

To apply a watch template to a device: 

1. With the Watch Template you want to apply open, right-click the 
desired device in the Network View. 

 

Figure 35: Apply Watch Template 
2. Select Apply Template from the Watch Template menu (Figure 

35). The Watch Template is now applied to the device (Figure 36). 

 

Figure 36: Applied Watch Template 
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Exporting Watch View Data 
You can export Watch View data to a Microsoft® Excel (.xls) format. 

To export Watch View data: 

1. Right-click in the Watch View template. 

2. Select Export device watch data (Figure 37). Microsoft Excel 
opens and displays the data you exported. 

 

Figure 37: Exporting Watch Data 
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Reinitializing the Controller 
You can use FX CommPro BACnet tool to reinitialize the controller 
by sending it a Cold Restart or Warm Restart command. Before you 
reinitialize the controller, you must first connect FX CommPro 
BACnet tool to the device. For more information, see Connecting to 
Devices. 

To reinitialize the controller: 

1. In the Network View, select the target device. 

Note: If necessary, you can select more than one target device. 

2. Right-click the selected device (Figure 38), and select Reinitialize 
Device. Two options appear:  

• Cold Restart 

Select Cold Restart to force a complete reboot of the controller. 

• Warm Restart 

Select Warm Restart to reinitialize controller. 

 

Figure 38: Reinitializing the Device 
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Commissioning Controllers 
Commissioning is a set of processes you use to ensure the controller 
works as expected. FX CommPro BACnet tool allows you to perform 
the following commissioning activities: 

• monitoring BACnet object properties 

• overriding the present values of BACnet input objects (Analog 
Input [AI], Binary Input [BI]) 

• commanding with priority the present value of BACnet output and 
value objects (Analog Output [AO], Binary Output [BO], Analog 
Value [AV], Binary Value [BV], and Multistate Value [MSV]) 

• changing other writable properties of BACnet objects 

Before you commission controllers, you must first connect 
FX CommPro BACnet tool to the device. For more information, see 
Connecting to Devices. 

Exploring the Device 
To commission a controller with the FX CommPro BACnet tool, you 
need to first explore the BACnet network profile of the device. The 
BACnet network profile contains all of the objects exposed to the 
BACnet network. The BACnet network profile is defined when the 
application software is configured with FX Builder or FX Builder 
Express. If you want FX CommPro BACnet tool to explore the objects 
inside the FX controller, the controller must contain an application 
with a predefined BACnet network profile. 

After an application downloads to a controller, the Profile View 
populates with the BACnet network profile points. 

To explore a device: 

1. In the Network View, right-click on the target device and select 
Explore Profile (Figure 39). 
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Figure 39: Exploring the Profile 
2. The Profile View populates with the objects defined in the BACnet 

network profile (Figure 40). FX CommPro BACnet tool groups 
points by their object name or by their object instance number. 

 

Figure 40: Profile View (Grouped by Point Type) 
3. To change the grouping, right-click any area in the Profile View 

and select Sort By (Figure 41). 
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Figure 41: Changing the Grouping 
4. Select the desired sort type: Name or Instance Number. The Profile 

View displays the points grouped by the selected type. 

Viewing Object Details Using the Details View 
To view object details using the Details View, click on the desired 
object in the Profile View (Figure 42). Information about the selected 
object appears in the Details View. 

This method is a quick way to view object information; however, you 
can only view information about one object at a time. 

 

Figure 42: Viewing Object Details in the Details View 
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Viewing Object Details Using the Watch View 
To view details about multiple objects simultaneously, use the Watch 
View (Figure 43). The Watch View can contain details about multiple 
objects originating from one for more connected devices. The Watch 
View contains a table that allows you to sort objects by the following 
attributes: 

• Object Type 

• Status 

• Device Address 

• Object Name 

• Present Value 

• Unit of Measure 

• Polling Rate 

The Watch View allows you to easily compare the present values of 
multiple objects.  

 

Figure 43: Viewing Objects in the Watch View 

Adding a Specific Object to the Watch View 
To add a specific object in the profile to the Watch View, 
double-click the object. 

Note: You can also right-click the object and select Add to Watch. 

Adding All Objects to the Watch View 
To add all the objects in the profile to the Watch View, right-click 
on the device in the Profile View and select Add all Objects to 
Watch. 
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Overriding Input Objects 
To override input objects: 

1. Select the input object you want to override. 

2. In the Details View, change the OutofService property from 
FALSE to TRUE. This action disconnects the present value 
property from the physical input of the controller.  

3. Double-click on the present value property in either the Watch 
View or Details View. 

4. Change the value as needed and press Enter. 

 

Figure 44: Edit Value Window 
5. To release the override, change the OutofService property to 

FALSE. This action reconnects the present value property to the 
physical input of the controller. 
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Overriding Output Objects 
To override output objects: 

1. Select the output object you want to override. 

Note: Do not change the OutofService property from FALSE to 
TRUE in the Details View. This action disconnects the present 
value property of the object from the physical controller. 

2. Double-click on the present value property in either the Watch 
View or Details View. 

3. Change the value as needed and press Enter. FX CommPro 
BACnet tool writes the selected output object’s present value 
property at the priority defined in the tool settings. 

4. To release the override, right-click the present value field in the 
Watch View and select Relinquish. This action sets the priority 
command to Null and restores the present value of the selected 
object to local control. 

Adjusting Analog, Binary, and Multistate Value Objects 
To adjust the present value property of an AV, BV, or MSV object, the 
present value property must be writable (also known as 
commandable). For FX Field Controllers, an AV, BV, and MSV object 
present value property is only writable when mapped to an input 
application point within the software application at design time using 
the FX Builder BACnet Protocol plug-in. 

To adjust analog, binary, and multistate value objects: 

1. Select the object you want to adjust. 

2. Double-click the present value property in either the Watch View 
or Details View. 

3. Change the value as needed and press Enter. FX CommPro 
BACnet tool writes the selected object’s present value property at 
the priority defined in the tool’s settings. 

4. To release the adjust command, right-click on the present value 
field in the Watch View and select Relinquish. This action reverts 
the present value property to the default value defined in the 
application software. 
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Adjusting Other Writeable Properties of BACnet Objects 
To adjust other properties of BACnet objects (Description, for 
example), the property must be writable as indicated by a white 
background in the Edit Value Window (Figure 44). 

To adjust the value of the property: 

1. Select the object that contains the property you want to adjust. 

2. Double-click the property (or select the drop-down box) in the 
Details View. 

3. Change the value as needed and press Enter. The change is 
permanent until another change is made. 
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Peer-to-Peer Bindings 
In a BACnet peer-to-peer network, two or more devices communicate 
directly with each other. A device can read values from (pull mode) or 
write values to (push mode) another device. 

FX Field Controllers with the BACnet card option provide support for 
peer-to-peer networking. The following peer-to-peer restrictions apply: 

• Binding is only allowed between objects that belong to different 
devices (not to objects belonging to the same device). 

• Binding is only allowed between objects of the same type group. 
The three object group types are Analog (AI, AO, AV), Binary 
(BI, BO, BV), and Multistate (MSV). 

• The total number of bindings allowed per device is limited  
(Table 2). 

Table 2: Maximum Number of Bindings Supported 
Device ximum Number oMa f Bindings 
FX07 20 
FX14 20 
FX16 40 

 

Setting up Peer-to-Peer Communication Bindings 
: 

vice you wish to 

 

To set up peer-to-peer communication bindings

1. From the Network View, right-click on the de
make the peer-to-peer binding client (the device requesting the 
data) and select P2P Binding (Figure 45). The Peer-to-Peer 
Plug-in appears, showing the Client Device you selected (Figure
46). 
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Figure 45: Opening the Peer-to-Peer Plug-in 

 

Figure 46: Peer-to-Peer Plug-in 
2. Right-click the Server Devices area and select Add Network 

Devices (Figure 47). The Select Server Devices window appears, 
listing devices on the network that you can select to be servers. 

 



 FX Tools Software Package - FX CommPro BACnet User Guide  41 

 

Figure 47: Add Server Devices 
3. Check the box next to the desired servers, or click Select All or 

Unselect All (Figure 48). Click OK. The Retrieving P2P 
Information window appears (Figure 49).  

 

Figure 48: Select Server Devices Window 

 

Figure 49: Retrieving P2P Information Window 
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4. Click Start to initiate a retrieval of the object information inside the 
targeted server device. A progress bar indicates status. When the 
progress bar displays Completed, click OK. The Peer-to-Peer 
Plug-in main screen appears.  

5. In the Client Profile window, expand the devices objects to show 
the object properties. 

6. Right-click on the desired property to share and select Create 
Binding (Figure 50). The Bindings Window is populated with the 
Client Object and the Server Device. 

 

Figure 50: Creating a Binding 

7. Click  to browse to the desired server object property. The 
Select Server Object window appears. 

8. Select the desired server object property and click OK. 

 

Figure 51: Selecting Server Object 
9. Select the Peer-to-Peer mode. 
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Figure 52: P2P Mode 
10. Select Pull if you want the client device to request data from the 

server device. Select Push if you want the client device to send 
data to the server device. See Figure 52. 

11. When you are finished making all the desired bindings, select 
Download Table from the Network menu to download the binding 
configuration to the target devices. 

Reusing Peer-to-Peer Binding Configurations 
If desired, you can save the binding configuration to a file for reuse. 

To reuse peer-to-peer binding configurations: 

1. Select Save from the File menu. 

 

Figure 53: Saving a Binding Configuration 
2. Enter the desired file name for the binding configuration and click 

Save. 
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Installing a Previously Saved Binding Configuration to a 
Controller 
To install a previously saved peer-to-peer binding configuration 
controller: 

1. Select Open from the File menu to retrieve a previous binding 
configuration file. 

2. Select Download Table from the Network menu to download the 
binding configuration to the target devices. 

Uploading Peer-to-Peer Binding Configuration 
To upload the binding configuration from a devices, select the Upload 
Table option from the Network menu. The Peer-to-Peer Binding 
Configuration table loaded in the target controller appears in the 
plug-in. You can then edit the configuration and re-download it if 
desired. 
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Specifications and Technical 
Data 

Ordering Codes 
Table 3: Software 
Product Code Product Description 
LP-FXTPRO-0 FX Tools Pro CD ROM (FX Builder, FX CommPro N2, FX CommPro LON, FX 

CommPro BACnet® software, FX Loader and MD LON Loader) - New User 
LP-FXTPRO-6 FX Tools Pro CD ROM (FX Builder, FX CommPro N2, FX CommPro LON, FX 

CommPro BACnet, FX Loader, and MD LON Loader) - upgrade 

 

Technical Specifications 
Table 4: FX CommPro BACnet Tool 
System Requirements 
Operating System Microsoft Windows 2000 (with Service Pack 4 or later) 

Microsoft Windows XP® (with Service Pack 2 or later) 
Processor Intel® Pentium® Processor, 500 MHz or higher 
RAM Minimum 512 MB RAM (1 GB recommended) 
Hard Disk 60 MB available hard disk storage for FX Tools 

2.5 MB (typical) to 6 MB (maximum) for each application file 
Display Display resolution 800 x 600 16-bit (32,768) color minimum 

Hardware 
Requirements 

Network 
Interface 

10/100 Mbps Ethernet   
USB for MS/TP Router Power 

Software Requirements Microsoft .NET Framework Version 2.0 

The performance specifications are nominal and conform to acceptable industry standards. For application at conditions 
beyond these specifications, consult the local Johnson Controls® office. Johnson Controls, Inc. shall not be liable for damages 
resulting from misapplication or misuse of its products. 
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